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Change Log

Change Log

The following Change Log explains by Product Version, Heading, Page, and Reason where 
changes in the ProgressBook StudentInformation EZ Query Guide have been made.

Product
Version Heading Page Reason

20.4.0 "View Student’s EMIS Reportable 
Data"

15 Updated screenshots to reflect new user interface and 
that the Limited English Proficiency field has been 
renamed English Learner.

20.4.0 "Compare Student’s Home 
School and JVS Data"

24 Updated screenshots to reflect new user interface and 
that the Limited English Proficiency field has been 
renamed English Learner.

20.0.0 "Compare Student’s Home 
School and JVS Data"

24 Updated the Shared Student Data – EMIS - Graduate 
screenshot to reflect new fields.

20.0.0 "SIS Student Search" 65 Updated text to reflect the new Non-Public SSID 
checkbox for non-public districts and schools.

N/A "Add District Trusts" 34 Removed note.
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Overview

Overview

The EZ Query menu provides access to StudentInformation data in read-only format. 

Note: If you have the job function of Teacher in StudentInformation security, you 
can see data for your students (assigned to your course sections). In order to see 
other students, if you have the Teacher job function, any other job function, or no 
job function assigned, your user account must be set up either with the associated 
staff member impersonations or the option to Allow Staff Members to view all 
Students in EZ Query in order for you to see this data. For more information, see 
the ProgressBook StudentInformation Security Guide.

• To view data for a single student, see “Individual Student Data.”
• To view classroom management resources, see “Tools.”
• To view reports, see “Reports.”
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Individual Student Data

Individual Student Data

EZ Query’s EZ Students screens let you view data for an individual student. 

Note: If you have the job function of Teacher in StudentInformation security, you 
can see data for your students (assigned to your course sections). In order to see 
other students, if you have the Teacher job function, any other job function, or no 
job function assigned, your user account must be set up either with the associated 
staff member impersonations or the option to Allow Staff Members to view all 
Students in EZ Query in order for you to see this data. For more information, see 
the ProgressBook StudentInformation Security Guide.

Refer to the appropriate topic as follows:

• “View Student’s Attendance” 
• “View Student’s Contacts” 
• “View Student’s Course History” 
• “View Student’s Course Requests” 
• “View Student’s Demographic Data” 
• “View Student’s Discipline Records” 
• “View Student’s EMIS Reportable Data” 
• “View Student’s Enrollment History” 
• “View Student’s School Medical Records” 
• “View Student’s Memberships and Special Education Services” 
• “View Student’s Schedule” 
• “Compare Student’s Home School and JVS Data” 
• “View Student’s Fees” 
• “View Student’s Marks” 

View Student’s Attendance
Note: For detailed information about student attendance, see the ProgressBook 
StudentInformation Attendance and Calendar Guide.

Navigation: StudentInformation > EZ Query > EZ Students > Attendance
With a student in context, the Attendance screen displays the student’s overall attendance rate 
and attendance incidents broken out by attendance code in both pie chart and table format.

To view the student’s absence history for previous school years and buildings, click View 
Absence History.



3 ProgressBook StudentInformation EZ Query Guide

Individual Student Data
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Individual Student Data

View Student’s Contacts
Note: For detailed information about student contacts, see the ProgressBook 
StudentInformation Student and Registration Guide.

Navigation: StudentInformation > EZ Query > EZ Students > Contact
1. With a student in context, on the Contact screen drop-down list, select the format in which 

you want to display information about the student’s contacts.

2. (Optional) If you want this screen to default to your display format selection each time, click 
Set As Default.

The contact information displays based on the display format you selected as follows:

Absence History



5 ProgressBook StudentInformation EZ Query Guide

Individual Student Data

Display Format – AddressLabels
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Individual Student Data

Display Format – AddressLine
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Individual Student Data

Display Format – AddressLine2

Display Format – AddressLineGrid
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Individual Student Data

Display Format – ExpandedAddress
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Individual Student Data

View Student’s Course History
Note: For detailed information about student course history, see the 
ProgressBook StudentInformation Course History, Class Rank, and Transcripts 
Guide.

Navigation: StudentInformation > EZ Query > EZ Students > Course History
1. With a student in context, on the Course History screen drop-down list, select the format 

in which you want to display information about the student’s course history.

2. (Optional) If you want this screen to default to your display format selection each time, click 
Set As Default.

Display Format – AddressLabelsLocal
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Individual Student Data

The course history information displays based on the display format you selected as 
follows:

Display Format – CourseHistoryGradesGrid
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Individual Student Data

Display Format – CourseHistoryGradesGridFinal
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Individual Student Data

Display Format – CourseHistoryMainGrid
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Individual Student Data

View Student’s Course Requests
Note: For detailed information about student course history, see the 
ProgressBook StudentInformation Scheduling Guide.

Navigation: StudentInformation > EZ Query > EZ Students > Course Requests
With a student in context, the Course Requests screen displays the student’s current course 
requests.

View Student’s Demographic Data
Note: For detailed information about student demographics, see the 
ProgressBook StudentInformation Student and Registration Guide.

Navigation: StudentInformation > EZ Query > EZ Students > Demographic
With a student in context, the Demographic screen displays the student’s picture, basic 
demographic data, and admission data. 
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15 ProgressBook StudentInformation EZ Query Guide

Individual Student Data

View Student’s Discipline Records
Note: For detailed information about discipline, see the ProgressBook 
StudentInformation Discipline Guide.

Navigation: StudentInformation > EZ Query > EZ Students > Discipline
With a student in context on the Discipline screen, review the student’s discipline data.

View Student’s EMIS Reportable Data
Note: EMIS reportable data for years prior to FY09 is not available on this screen.

Note: For detailed information about student EMIS reportable data, see the 
ProgressBook StudentInformation Student and Registration Guide.

Navigation: StudentInformation > EZ Query > EZ Students > EMIS Demographic
With a student in context, on the EMIS Demographic screen, in the Choose data to view 
drop-down list, select the type of EMIS data you want to display for the student. The selections, 
with the exception of EMIS - Student, are based on student profile tabs containing EMIS 
reportable data.
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Individual Student Data

The EMIS information displays based on your selection as follows:

EMIS Reportable Data – From FS - Standing Tab of Profile

EMIS Reportable Data – From FS - Attendance Tab of Profile
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Individual Student Data

EMIS Reportable Data – From FD - Attributes Tab of Profile

EMIS Reportable Data – From FN - Attributes Tab of Profile
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Individual Student Data

EMIS Reportable Data – From FN - Graduate Tab of Profile

EMIS Reportable Data – EMIS - Student (Not From Profile)
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Individual Student Data

View Student’s Enrollment History
Note: EMIS enrollment data for years prior to FY09 is not available on this screen.

Note: For detailed information about student enrollment, see the ProgressBook 
StudentInformation Student and Registration Guide.

Navigation: StudentInformation > EZ Query > EZ Students > Enrollment
With a student in context, the Enrollment screen displays the student’s enrollment history for all 
school years for which the student was enrolled in a school or district using StudentInformation.

View Student’s School Medical Records
Note: For detailed information about student medical information, see the 
ProgressBook StudentInformation Student Medical Guide.

Navigation: StudentInformation > EZ Query > EZ Students > Medical
With a student in context, the Medical screen displays any information about the student’s 
medical alerts, medication to be taken at school, health screening done by the school, and 
immunization records.

Note: Private Notes do not display in the student Medical Alerts grid.
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Individual Student Data
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Individual Student Data

View Student’s Memberships and Special Education Services
Note: For detailed information about student memberships, see the 
ProgressBook StudentInformation Student and Registration Guide.

Navigation: StudentInformation > EZ Query > EZ Students > Membership/Service
1. With a student in context, on the Membership/Service screen, in the Select a Display 

Format From List drop-down list, select the format in which you want to display 
information about the student’s memberships and special education services:

• MembershipGrid – Sorts by membership or special education service code 
(ascending), then by school year (for multiple memberships with the same code).

• MembershipGridByMembership – Sorts by membership or special education 
service code (descending), then by school year (for multiple memberships with the 
same code).

• MembershipGridSchoolYearDesc – Sorts by school year (descending), then by 
membership or special education service code (descending).

Note: If FY12 or earlier is in context, this screen is named Membership.

2. (Optional) If you want this screen to default to your display format selection each time, click 
Set As Default.
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Individual Student Data

The membership/special education information displays based on the display format you 
selected as follows:

Memberships and Special Education Services – 
MembershipGrid

Memberships and Special Education Services – 
MembershipGridByMembership
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Individual Student Data

View Student’s Schedule
Note: For detailed information about student schedules, see the ProgressBook 
StudentInformation Student and Registration Guide and ProgressBook 
StudentInformation Scheduling Guide.

Navigation: StudentInformation > EZ Query > EZ Students > Schedule
1. With a student in context, on the Schedule screen, select the Type(s) of course section 

assignments you want to view for this student and the Fields to Display in the grid.

2. Click Display.

Memberships and Special Education Services – 
MembershipGridSchoolYearDesc
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Individual Student Data

The student’s current course schedule displays based on the options you selected.

Compare Student’s Home School and JVS Data
Note: Before you can view and compare data from the JVS, your school district 
must set up the JVS as a trusted district. For information on this setup, see “Add 
District Trusts.”

Note: Data for years prior to FY09 is not available on this screen.

Navigation: StudentInformation > EZ Query > EZ Students > Shared Student Data
1. With a student in context, on the Shared Student Data screen, in the Choose trusted 

district and school drop-down list, select the student’s JVS district for which you want to 
view data about the student.
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Individual Student Data

2. In the Choose data to review drop-down list, select one of the following types of data that 
you want to compare for the student:

• Addresses and Primary Contact
• Daily Absences
• General/Additional
• EMIS - FS
• EMIS - FD
• EMIS - FN
• EMIS - Graduate
• Schedule
• Assessments
• Course History
• Special Education Events

The data from both your school and the student’s JVS school displays for the school year 
in context based on the type of data you selected to compare. 

If you select Addresses and Primary Contact, comparative residence address data displays. 
You can view mailing address information or primary contact information by selecting the 
appropriate option in the Address or Primary Contact drop-down list.
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Individual Student Data

If you select Daily Absences, the Attendance Hours Summary grid displays, containing the 
student’s data from the attendance calculator, and comparative absence data displays below this 
grid for the period from the master calendar’s start date to today’s date. You can select a different 
date range by entering or selecting different dates in the Absences From and Absences To 
fields and then clicking Filter.

Note: The comparative absence data does not display period absences.

Shared Student Data – Daily Absences
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Individual Student Data

Shared Student Data – General/Additional
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Individual Student Data

If you select EMIS - FS, comparative data about the student’s FS record displays for a particular 
effective date during the school year in context. To view this comparative data for a different date 
on which the student’s FS record changed, in the Effective Date drop-down list, select a different 
date.

Shared Student Data – EMIS - FS
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Individual Student Data

If you select EMIS - FD, comparative data about the student’s FD record displays for a particular 
effective date during the school year in context. To view this comparative data for a different date 
on which the student’s FD record changed, in the Effective Date drop-down list, select a different 
date.

Shared Student Data – EMIS - FD

Shared Student Data – EMIS - FN
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Individual Student Data

  

SharedStudent Data – EMIS - Graduate
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Individual Student Data

If you select Schedule, comparative schedule data for the student displays. If you want to filter 
the display, click Show Filter & Display Options. Then select the status Type(s) of course 
section assignments you want to view for this student and the Fields to Display in the grid, and 
click Display.

Shared Student Data – Schedule

Show Filter & Display Options
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Individual Student Data

If you select Assessments, you can view comparative assessment score data for the student. To 
view this data, in the filter and display options area, select the checkbox beside each assessment 
score you want to view.
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Individual Student Data

If you select Course History, comparative course history data for the student displays for all 
school years and credit types. If you want to filter the display, select the school year(s) and credit 
type(s) to include by moving them from the associated dual listboxes on the left to the ones on the 
right, select the checkbox beside each type of manual course record you want to view (Is High 
School Credit, Include in GPA, and/or Include in Total Credits), and click Display.
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Individual Student Data

If you select Special Education Events, comparative special education event data displays for 
the student. You can also show previous years or inactive events by deselecting the Show 
Current Year Only or Active Events checkboxes, respectively. You can select a different date 
range by entering or selecting different dates in the From Date and To Date fields. Then click 
Display.

Add District Trusts
Navigation: StudentInformation > Management > District Administration > District Trusts
District trusts are relationships you set up at the district level to designate another district (such as 
a JVS) as a trusted district. This type of relationship provides a read-only “window” for districts to 
share data about students they have in common.
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Individual Student Data

1. On the District Trusts screen, click Add District Trust.

The add/edit version of the screen displays.

2. In the Trusted District drop-down list, select the district that you want to allow to view data 
for your students in common.

3. In the Trust Type field, select the EZ Query checkbox.

4. Click Save. Or to continue adding district trusts, click Save and New.
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Individual Student Data

A confirmation message displays, and the district now displays in the list of district trusts.
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Individual Student Data

View Student’s Fees
Note: For detailed information about student fees, see the ProgressBook 
StudentInformation Fees Guide.

Navigation: StudentInformation > EZ Query > EZ Students > Student Fees
With a student in context, the Student Fees screen displays fee information for the student. If you 
want to hide certain types of fees, in the Fee Options area, deselect the fees type(s).
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Individual Student Data

View Student’s Marks
Note: For detailed information about student current courses and marks, see the 
ProgressBook StudentInformation Scheduling Guide and ProgressBook 
StudentInformation Marks Guide.

Navigation: StudentInformation > EZ Query > EZ Students > Student Marks
With a student in context, the Student Marks screen displays the student’s marks for each current 
course based on the finalized schedule of the school and school year in context.

You can select different course terms to display by moving them from the Course Terms dual 
listbox on the left to the Selected listbox on the right and clicking View.
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Tools

Tools

EZ Query’s Tools screens provide a collection of classroom management resources.

Note: If you do not have access to these screens on the site map, these options 
do not display. If you do, you can access all students regardless of your job 
function and without using staff impersonations. For more information, see the 
ProgressBook StudentInformation Security Guide.

Refer to the appropriate topic as follows:

• “View My Class Schedule” 
• “Generate Student List” 
• “Maintain Seating Charts” 
• “Generate Absence List” 
• “View Teacher Directory” 
• “View Upcoming Student Birthdays” 

View My Class Schedule
Navigation: StudentInformation > EZ Query > Tools > Teacher Class Schedule
On the Teacher Class Schedule screen, you can see your own schedule or that of another 
teacher by class period. Select the Teacher, Term, and at least one Day Of The Week, and click 
View Schedule.
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Tools

Generate Student List
Navigation: StudentInformation > EZ Query > Tools > Student List

Note: If you do not have the job function of teacher in StudentInformation security, 
to use this option, you must have the permission to Allow Staff Member to view 
all Students in EZ Query. For more information, see the ProgressBook 
StudentInformation Security Guide.

On the Student List screen, you can view and download a list of students assigned to specific 
course sections as a detailed list or picture list. Select your criteria, and click Build List.

Note: For information on running reports, see the ProgressBook 
StudentInformation Getting Started Guide.
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Tools

If you select Detailed Information, student demographic details display. If you select Picture 
List, an image of each student displays if available.

Student List – Detailed Information

Student List – Picture List
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Tools

Maintain Seating Charts
You can maintain classroom seating charts in StudentInformation in the following ways:

• To view an existing seating chart, see “View Seating Charts.”
• To create a new seating chart, see “Create Seating Charts.”
• To assign seats to students, see “Assign Seats.”
• To edit the setup of an existing seating chart, see “Edit Seating Charts.”
• To delete a seating chart, see “Delete Seating Charts.”

View Seating Charts
Navigation: StudentInformation > EZ Query > Tools > Seating Chart
You can see classroom seating charts for your own classes or those of another teacher. 

1. On the Seating Chart screen, select the Teacher and Date, and click Go.

A list of seating charts for the indicated teacher and date displays.
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Tools

2.  Click the name of the seating chart you want to view.

The selected seating chart displays.

Note: For information on assigning seats to students, see “Assign Seats.”
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Tools

Create Seating Charts
Navigation: StudentInformation > EZ Query > Tools > Seating Chart
You can create one or more classroom seating charts per course section for your own classes or 
those of another teacher.

1. On the Seating Chart screen, select the Teacher and Date.

2. Click Add Seating Chart.

The add/edit version of the screen displays.

3. In the Period drop-down list, select a class period (course section) specific to the teacher 
for whom you are creating the seating chart.

4. For the Start In Corner option, select the radio button that corresponds to the physical 
corner of the room where you wish to start creating the seating chart (i.e., top left, top right, 
bottom left, or bottom right).

5. (Optional) Specify a number of Columns for the seating chart.

Note: If you leave this field blank, StudentInformation calculates the number of 
columns based on the number of students.

6. In the Pictures drop-down list, select the scaling of the student picture size (from 10% to 
200% of original size).

7. To make the student pictures display on the seating chart, select the Show checkbox. To 
hide them, deselect the checkbox.

8. (Optional) Select a Collision Mode to determine what should happen if you move a 
student into a seat that displaces another student:

• Switch target with source – Switches the two students.
• Move target to end – Moves displaced student to the end of the seating chart.

9. If the Location drop-down list is activated (i.e., not grayed out), select the course section 
location.
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Tools

10. In the Render drop-down list, select how you want to arrange the student names and/or 
pictures on the seating chart (Across or Up and Down).

11. In the Sort By drop-down list, select how you want to sort the student names and/or 
pictures on the seating chart (Student Name Ascending, Student Name Descending, 
or Random). 

12. (Optional) Specify a number of Rows for the seating chart.

Note: If you leave this field blank, StudentInformation calculates the number of 
rows based on the number of students.

13. Select the Perspective of the student seats:

• In Seats – Prints the front of the classroom at the top, as if you are sitting in one of the 
seats.

• Facing Seats – Prints the front of the classroom at the bottom, as if you are standing 
at the front of the classroom and facing the seats.

14. (Optional) If you want the seat number drop-down list to display on the seating chart, select 
the Move Drop Down checkbox.

15. Click Generate.

The screen expands to display more options.

16. (Optional) If you need to make any changes to the original fields you completed, make the 
changes and click Update.

17. Enter a Name for this seating chart.

18. (Optional) If you do not want this seating chart to be currently active, deselect the Is Active 
checkbox.
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Tools

19. Click Save.

The new seating chart displays on the Seating Chart screen.

Note: You still need to assign seats to students. For information on this 
procedure, see “Assign Seats.”
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Tools

Assign Seats
Navigation: StudentInformation > EZ Query > Tools > Seating Chart
You can assign seats to students immediately after creating the seating chart (see “Create 
Seating Charts.”) or at a later time if new students join your class or you want to reassign seats.

1. On the Seating Chart screen, select the Teacher and Date, and click Go.

A list of seating charts matching your criteria displays.

2. Click the name of the seating chart.

The seat assignment version of the screen displays.
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Tools

3. For any student who is new or unassigned to a seat, in the associated New Student 
drop-down list, select a seat number for the student.



49 ProgressBook StudentInformation EZ Query Guide

Tools

StudentInformation assigns the seat(s) to the student(s).
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Tools

Edit Seating Charts
Navigation: StudentInformation > EZ Query > Tools > Seating Chart
You can edit the setup of an existing seating chart.

1. On the Seating Chart screen, select the Teacher and Date, and click Go.

A list of seating charts matching your criteria displays.

2. In the row of the seating chart you want to edit, click .

The add/edit version of the screen displays.
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Tools

3. Make any desired changes, and click Save.

Note: For more information about the fields on this screen, see “Create Seating 
Charts.”

Delete Seating Charts
Navigation: StudentInformation > EZ Query > Tools > Seating Chart

1. On the Seating Chart screen, select the Teacher and Date, and click Go.

A list of seating charts matching your criteria displays.



ProgressBook StudentInformation EZ Query Guide 52

Tools

2. In the row of the seating chart you want to delete, click .

A message displays, asking if you are sure you want to delete the seating chart.

3. Click OK.

The seating chart no longer displays on the Seating Chart screen.
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Generate Absence List
Navigation: StudentInformation > EZ Query > Tools > Absence List
On the Absence List screen, you can view and download a list of all student absences by date 
for the school in context. Select your criteria and click View.

Note: For information on running reports, see the ProgressBook 
StudentInformation Getting Started Guide.

Note: The Absence Reason, Absence Note, and Absence Comments column 
options do not display if your school, district, or ITC has chosen to make them 
unavailable. For more information, see the ProgressBook StudentInformation 
School Year Setup and Configuration Guide.
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Tools

Absence List – Select Criteria
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Tools

View Teacher Directory
On the Teacher Directory screen, you can look up contact information for a specific teacher by 
selecting the Teacher and clicking Lookup Teacher.

Absence List
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View Upcoming Student Birthdays
Navigation: StudentInformation > EZ Query > Tools > Upcoming Birthdays

Note: If you do not have the job function of teacher in StudentInformation security, 
to use this option, you must have the permission to Allow Staff Member to view 
all Students in EZ Query. For more information, see the ProgressBook 
StudentInformation Security Guide.

You can view upcoming student birthdays by school in both list and calendar formats. See the 
appropriate topic as follows:

• “View Birthday List” 
• “View Birthday Calendar” 

View Birthday List
1. On the Upcoming Birthdays screen, in the drop-down list, select the school for which you 

want to view student birthdays. 

2. Select the List format.

3. Click Submit.

The screen displays a list of all birthdays of active students coming up in the next week.

4. (Optional) To change the date range of birthdays in the list, in the Birthdate Date Range 
fields, enter or select a beginning and ending date, and click Refresh.
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Tools

The screen refreshes to display the upcoming birthdays for the selected date range.

View Birthday Calendar
1. On the Upcoming Birthdays screen, in the drop-down list, select the school for which you 

want to view student birthdays. 

2. Select the Calendar format.

3. Click Submit.

The screen displays a calendar showing birthdays of all active students for the current 
month.
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Tools

4. (Optional) To display the previous or next month’s birthday calendar, click  or , 
respectively.
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Tools

The screen refreshes to display the birthdays for the selected month.
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Reports

Reports

EZ Query reports provide multiple ways to display and download student data. For information on 
running reports, see the ProgressBook StudentInformation Getting Started Guide.

Note: If you do not have access to these screens on the site map, these options 
do not display. If you do, you can access all students regardless of your job 
function and without using staff impersonations. For more information, see the 
ProgressBook StudentInformation Security Guide.

Refer to the appropriate topic as follows:

• “Absence Graph” 
• “Download Class List” 
• “Download Student Address” 
• “Download Student Medical History” 
• “Medicaid Eligibility Rate (MER) Download” 
• “SIS Student Search” 
• “Student Membership/Services Search” 
• “List of Students Without Disciplinary Incidents” 
• “Weekday Attendance Percentage” 

Absence Graph
Navigation: StudentInformation > EZ Query > Reports > Absence Graph
You can view absences or tardies for the current school year in graph or list format.

1. On the Absence Graph screen, in the drop-down list, select the school for which you want 
to view absences or tardies.

2. (Optional) Select a Grade and/or Gender to filter results by those criteria.

3. For the Absence Type option, select whether to display Absent or Tardy records.
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4. Select how you want to view the absence or tardy data as follows:

• Display Graph – Displays in graphical format.
• Display Data – Displays in list format.

If you click Display Graph, the absence or tardy data from the beginning of the school year 
until the current date displays in graphical format using the following data points:

• Headcount – Total number of active status students.
• ADM – Average daily membership.
• Total Absent Type – Total number of absences or tardies.
• Percent Present – Percent of students present.
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If you click Display Data, the absence or tardy data from the beginning of the school year 
until the current date displays in list format by date using the following data points:

• Date – Date of the school day for which absence or tardy data is reported.
• Head Count – Total number of active status students.
• ADM – Average daily membership.
• Total – Total number of absences or tardies.
• Average – Average attendance.

Note: Averages for the entire date range display at the bottom of the list.

Download Class List
Navigation: StudentInformation > EZ Query > Download Class List

Note: If you do not have the job function of teacher in StudentInformation security, 
to use this option, you must have the permission to Allow Staff Member to view 
all Students in EZ Query. For more information, see the ProgressBook 
StudentInformation Security Guide.
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This report displays a list of the school’s students and their schedules that you can further process 
and include in other applications.

Note: The State Student ID only appears in the output file if you have the proper 
security in Extra System Permissions – EMIS – View/Update State Student ID. 
For more information, see the ProgressBook StudentInformation Security Guide.

Download Student Address
Navigation: StudentInformation > EZ Query > Reports > Download Student Address
This report displays a list of students and their addresses that you can further process and include 
in other applications. You can download all contact addresses for each student or just the primary 
address.

Download Student Address – All Addresses

Download Student Address – Primary Address Only
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Download Student Medical History
For information on this report, see the ProgressBook StudentInformation Student Medical Guide.

Medicaid Eligibility Rate (MER) Download
Navigation: StudentInformation > EZ Query > Reports > Medicaid Eligibility Rate (MER) 
Download
You can use this download to collect and report Medicaid eligibility information from the previous 
school year. This report creates a file that includes all students eligible for Medicaid who were 
enrolled at some point during reporting week of the school year in context.

1. Select a school in context in order for the drop-down list to populate with the applicable 
school district.

2. Select the correct year to be in context. This should be the year designated by your 
third-party billing agent.

3. On the Medicaid Eligibility Rate (MER) Download screen, in the drop-down list, select 
the school district, and click Create Download File.

StudentInformation generates a fixed length export file using spaces for padding. The file 
includes the following fields (with starting position and length indicated in parentheses):

• Student First Name (1, 20)
• Student Last Name (21, 30)
• Student Residence Zip Code (51, 5)
• Student Birth Date (56, 8) – in mmddyyyy format
• District IRN (64, 6)
• Special Education Eligibility (70, 1) – in Y/N format
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SIS Student Search
Navigation: StudentInformation > EZ Query > Reports > SIS Student Search

Note: If you do not have the job function of teacher in StudentInformation security, 
to use this option, you must have the permission to Allow Staff Member to view 
all Students in EZ Query. For more information, see the ProgressBook 
StudentInformation Security Guide.

On the SIS Student Search screen, you can search for students using a variety of filter criteria 
and then download the results with numerous output field options. You can also configure and 
save search parameter sets so that it is easy to run the same search on a regular basis. This 
screen is available at both the district level and the building level.

Note: StudentInformation uses the current date as the effective date when 
searching EMIS records. Before the school year begins, it uses the maximum 
calendar master start date; after the school year ends, it uses the minimum 
calendar master stop date.

1. (Optional) If you have previously saved a parameter set, at the bottom of the screen in the 
drop-down list, select the name of the parameter set you wish to run and then click Apply.
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Your saved selections display on each applicable tab and you can proceed to the 
Summary tab to run the search.

2. If you do not have a search saved, select your search criteria as you tab through each of 
the options and subtabs.

Following are important notes regarding the SIS Student Search options.

• Filter Criteria tab’s Ad Hoc subtab – If you select an ad-hoc membership as part of 
your search criteria, StudentInformation ignores all other filters on all other subtabs. 

• Filter Criteria tab Students subtab:
• To enter only part of the name in any of the name fields, enter the first couple 

letters followed by %. (For example, to see all names starting with “Sa,” enter 
sa%.)

• Enter Student Numbers, Social Security Number, and EMIS ID separated by 
commas.

• Filter Criteria tab EMIS subtab – Enter SSID, District of Residence IRN, Sent To 
IRN, How Received IRN, Attending Building IRN, Admitted From IRN, and 
Withdrawn to IRN separated by commas.

• Field Selection tab Students subtab – The Non-Public SSID checkbox displays 
only if you have a non-public school or district in context.

• Field Selection tab EMIS subtab – The State Student ID (SSID) and Free/Reduced 
Lunch Status checkboxes display only if you have the proper security permissions. 
(For more information, see the ProgressBook StudentInformation Security Guide.)

3. (Optional) Once you have selected all your choices, you can name and save the set of 

parameters to use in later searches by clicking  and then Create.
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Enter a name for your parameter set and then click Save. You can now apply this 
parameter set and its selections when you wish to run it (see step 1).

Note: The parameter sets you save are visible only to you.

4. On the Summary tab, review the summary of your selection criteria.

5. Select your file download options and click Finish.
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The output file returns the students and fields matching your selection criteria.

Student Membership/Services Search
Navigation: StudentInformation > EZ Query > Reports > Student Membership/Services 
Search
You can search for specific memberships and services and the students who are associated with 
them.
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On the Student Membership/Services Search screen, select your criteria, and click View List.

Note: The Special Education Services dual listbox only displays if FY13 or later 
is in context. For prior years, you enter special education services on the Edit 
Student Memberships screen and select them for this report in the Membership 
Code dual listbox. 

A list of memberships/services and associated students displays at the bottom of the 
screen. 
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List of Students Without Disciplinary Incidents
Navigation: StudentInformation > EZ Query > Reports > Students Without Disciplinary 
Incident
You can view and download a list of all students without any disciplinary incidents.

1. On the List Of Students Without Disciplinary Incidents screen, in the drop-down list, 
select the school.

2. Select whether you want to view only Active Students or All Students.

3. (Optional) Select your file download options.

Note: If you do not select any file download options, the list displays at the bottom 
of the screen.

4. Click View Summary. 

The students with no disciplinary incidents who match your search criteria display in a 
report or on the screen, based on your selections.
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Students Without Disciplinary Incidents – 
Viewed on Screen

Students Without Disciplinary Incidents – Download File
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Weekday Attendance Percentage
Navigation: StudentInformation > EZ Query > Reports > Weekday Attendance Percentage
You can view a school’s absence and tardy percentages broken out by day of the week so you 
can track student absence trends.

1. On the Weekday Attendance Percentage screen, in the drop-down list, select the school 
for which you want to view absence or tardy percentages.

2. (Optional) Select a Grade and/or Gender to filter results by those criteria.

3. For the Absence Type option, select whether to display Absent or Tardy percentages.

4. Click Display.
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The absence or tardy percentages for the school and school year in context display in a 
bar graph and chart showing each day of the week and the attendance or tardy 
percentage.
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